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Welcome to Navicat 

Welcome to Navicat! 

Navicat Premium 

Navicat Premium is a multi-connections Database Administration tool allowing you to 

connect to MySQL, Oracle, PostgreSQL and SQLite databases simultaneously within a single 

application, making database administration to multiple kinds of database so easy. Navicat 

Premium combines the functions of other Navicat members. With connections established to 

different database types, Navicat Premium supports data transfer between MySQL, Oracle, 

PostgreSQL and SQLite. It supports most of the features in MySQL, Oracle, PostgreSQL and 

SQLite. 

Navicat Premium enables you to easily and quickly transfer data across various database 

systems, or to a plain text file with designated SQL format and encoding. This can simplified 

the process for migrating data from one server to another server type. Batch job for different 

kind of databases can also be scheduled and run at a specific time. 

Navicat for MySQL 

Navicat for MySQL is a powerful MySQL Database Server administration and development 

tool. It works with any MySQL version from 3.21 or above and supports most of the latest 

MySQL features including Trigger, Procedure, Function, Event, View, Manage User, and so 

on. 

Navicat for Oracle 

Navicat for Oracle is a powerful Oracle Database Server administration and development tool. 

It works with any Oracle version from 8.1 to the newest one and supports all Oracle objects 

including Directory, Tablespace, Synonym, Materialized View, Trigger, Sequence, Type and 

so on. 

Navicat for PostgreSQL 

Navicat for PostgreSQL is a powerful PostgreSQL Database Server administration and 

development tool. It works with PostgreSQL version 7.3 or above and supports most of the 

PostgreSQL features including Trigger, Function, View, Manage User, and so on. 
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Navicat for SQLite 

Navicat for SQLite is a powerful SQLite Database Server administration and development 

tool. It works with SQLite version 2 and 3 and supports most of the SQLite features including 

Trigger, Index, View, and so on. 

Hint: If you need to manage more then one kind of servers, then you should choose Navicat 

Premium. Otherwise, you can choose Navicat for MySQL, Navicat for Oracle, Navicat for 

PostgreSQL or Navicat for SQLite according to your server type. 

Navicat Feature 

Features in Navicat are sophisticated enough to provide professional developers for all their 

specific needs, yet easy to learn for users who are new to database server. With its 

well-designed Graphical User Interface(GUI), Navicat lets you quickly and easily create, 

organize, access and share information in a secure and easy way. 

Navicat is available on three platforms - Microsoft Windows, Mac OS X and Linux. It can 

connect users to local/remote server, providing several utility tools such as Data Transfer, 

Data/Structure Synchronization, Import/Export, Backup/Restore, Report Builder and 

Schedule to facilitate the process for data maintenance. See the Feature Matrix for details or 

visit our web-site: http://www.navicat.com
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System Requirements 

System Requirements for Windows 

• Microsoft Windows XP, Vista, Server 2003, Server 2008, Windows 7  

• Pentium II processor or above  

• Hard-disk space vary depending on installation. Full installation requires 65 MB of 

available hard-disk space.  

System Requirements for Mac OS X 

• Mac OS X 10.4 Tiger, 10.5 Leopard or 10.6 Snow Leopard  

• PowerPC G4 or above / Intel CPU  

System Requirements for Linux 

• Compatible with i386 PC  

• Supports 32-bit and 64-bit Linux platform  

• Supports Linux kernel version 2.2 or higher  

• Supports Glibc 2.4 or above  

• Supports GNOME and KDE 

Note: You need to install all 32-bit libraries before working on 64-bit Linux. 
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Feature Matrix 

Navicat provides the following versions for managing your servers. 

• Navicat Premium  

• Navicat for MySQL  

• Navicat for Oracle  

• Navicat for PostgreSQL  

• Navicat for SQLite  
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Navicat Premium 

 

Platforms 

Windows 

Enterprise 

Edition 

Windows 

Lite 

Edition 

Mac OS X 

Standard 

Edition 

Mac 

OS X 

Lite 

Edition 

Linux 

Standard 

Edition 

Linux 

Lite 

Edition 

MySQL Objects Management 

Supports MySQL Servers 3.21 or 

above 
+ + + + + + 

Create / Drop Databases + + + + + + 

Support all MySQL objects: tables, 

views, procedures/functions and 

events 

+ + + + + + 

Support all subobjects: fields, indices, 

foreign keys and triggers 
+ + + + + + 

Support of partitioning + + + + + + 

Support of character set and unicode + + + + + + 

Oracle Objects Management 

Supports Oracle Servers 8.1 or above + + + + + + 

Create/drop schemas + + + + + + 

Support all Oracle objects: tables 

(Normal, External and Index 

Organized), views, 

procedures/functions 

+ + + + + + 

Support all subobjects: fields, indices, 

foreign keys, uniques, checks and 

triggers 

+ + + + + + 

Managing directories, tablespaces, 

public database links and public 

synonyms 

+ + + + + + 

Managing database links, indices, 

java, materialized views, materialized 

view logs, packages, sequences, 

synonyms, triggers, types, XML 

Schema and Recycle Bin 

+ + + + + + 

Support of physical attributes + + + + + + 

Support of character set and unicode + + + + + + 
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PostgreSQL Objects Management 

Supports PostgreSQL Servers 7.3 or 

above 
+ + + + + + 

Create /drop databases and schemas + + + + + + 

Support all PostgreSQL objects: 

tables, views and functions 
+ + + + + + 

Support all subobjects: fields, indices, 

foreign keys, uniques, checks, rules 

and triggers 

+ + + + + + 

Managing tablespace + + + + + + 

Managing cast and languages + + + + + + 

Managing aggregates, conversions, 

domains, trigger functions, operators 

and classes, sequences and types 

+ + + + + + 

Support of character set and unicode + + + + + + 

SQLite Objects Management 

Supports SQLite 2 and 3 + + + + + + 

Attach/detach databases + + + + + + 

Support all SQLite objects: tables and 

views 
+ + + + + + 

Support all subobjects: triggers and 

indices 
+ + + + + + 

Support to view master table + + + + + + 

Support of character set and unicode + + + + + + 

Connection Management and Navigation 

Multiple local/remote server 

connections 
+ + + + + + 

Support of Oracle Basic Connection + + + + + + 

Support of Oracle TNS Connection + + + + - - 

Support to connect a new or an 

existing SQLite database 
+ + + + + + 

Support encrypted SQLite file 

(wxSQLite3) 
+ + + + + + 

Connection to 

MySQL/Oracle/PostgreSQL Server 

through SSH 

+ + + + + + 
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Connection to 

MySQL/PostgreSQL/SQLite Server 

through HTTP 

+ + + + + + 

Support SSL secure connection for 

MySQL and PostgreSQL 8.4 above 
+ + + + + + 

Export/Import connections settings + + + + + + 

Customize selected 

MySQL/PostgreSQL databases to 

work with 

+ + + + + + 

Feature Rich Oracle PL/SQL Code Debugger 

Support on showing interactive and 

real-time debugging information 
+ - + - + - 

Ability to set simple and complex 

breakpoints 
+ - + - + - 

Stepping through a function, i.e. Step 

Into, Step Over and Step Out 
+ - + - + - 

Inspecting variables and expressions + - + - + - 

Stack traces + - + - + - 

Data Viewer and Editor 

Grid view + + + + + + 

Form view + - + - + - 

Text, Hex and BLOB viewer/editor + + + + + + 

Oracle BFile viewer/editor + + + + + + 

Copying and pasting selected records + + + + + + 

Customize display formats + + + + + + 

Incremental search, sorting and 

formatting table grid 
+ + + + + + 

Ability to show/hide Oracle and SQLite 

tables ROWID 
+ + + + + + 

Support of raw mode edit: apply 

MySQL/PostgreSQL/SQLite built-in 

function 

+ + + + + + 

Support of foreign key data selection: 

locate the available values from the 

reference table 

+ - + - + - 

Filtering Records + - + - + - 
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Ability to set number of records 

showing on each page 
+ + + + + + 

SQL Processing 

Visual query/view builder to facilitate 

the process of building complicated 

queries 

+ - + - + - 

Ability to create parameter queries + + + + + + 

Code completion for SQL editors + - + - + - 

Code outline for Oracle 

functions/procedures/packages/types 
+ - + - + - 

SQL Code Beautifier + + + + + + 

Multiple SQL editors with syntax 

highlighted feature 
+ + + + + + 

Support code folding, highlighted 

matches words and brackets 
+ + + + + + 

Copy SQL with quote + + + + + + 

Word Wrap + + + + + + 

Zoom In/Out for SQL editors + + + + + + 

Enhanced find and replace options in 

SQL editors 
+ + + + + + 

Ability to preview SQL before 

execution 
+ + + + + + 

Support to return multi-resultsets + + - - + + 

SQL console + + + + - - 

Diversified Import and Export Competence 

Importing data from ODBC: MSSQL, 

Oracle etc 
+ - + - - - 

Importing data from MS Excel + - + - - - 

Importing data from MS Access + - - - - - 

Importing data from plain text file 

formats : TXT, CSV, XML etc 
+ + + + + + 

Importing data from other file 

formats : DBF etc 
+ - + - + - 

Exporting data to MS Excel  + - + - + - 

Exporting data to MS Access  + - - - - - 

Exporting data to HTML + - - - + - 
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Exporting data to plain text file 

formats: TXT, CSV, XML etc 
+ + + + + + 

Exporting data to most popular 

formats: DBF etc 
+ - + - + - 

Other Data Manipulation Tools 

Data transfer (Same or cross server 

type) 
+ - + - + - 

Transferring data to SQL script as 

INSERT statement 
+ - + - + - 

Transferring data to a SQL file with 

designated SQL format and encoding 
+ - + - + - 

Data synchronization + - + - + - 

Structure synchronization + - + - + - 

Backup/Restore for MySQL/PostgreSQL/SQLite 

Backing up/restoring database + - + - + - 

Backing up database with chosen 

database objects 
+ - + - + - 

Restoring database with chosen 

database objects 
+ - + - + - 

Converting backup file into SQL script + - + - + - 

Compressing/Decompressing Backup 

files 
+ - - - + - 

Schedule for Batch Job  

Ability to set schedule on backup, 

query execution, import/export, data 

transfer and data synchronization 

+ - + - + - 

Ability to run profiles from different 

servers in a single schedule job 
+ - + - + - 

Schedule report printing + - - - - - 

Schedule to print report to files: PDF, 

Excel, HTML etc 
+ - - - - - 

Sending notification e-mail for 

schedule task 
+ - + - + - 

Ability to attach Export Wizard/Report 

result files in Batch Job notification 

email 

+ - + - + - 
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Notification email supports SSL/TLS + - - - + - 

Server Security and Maintenance Services 

Visual user manager to administer 

users, groups (roles) and privileges 
+ + + + + + 

Ability to duplicate MySQL user + - + - + - 

Maintance database/schema objects + + + + + + 

Server Monitor to view system 

variables and server status 

information 

+ - + - + - 

Report Management Tools 

Report Builder + - - - - - 

Report Viewer + - - - - - 

Other Useful Features  

Objects search filter + + + + + + 

Backing up database/schema/table to 

SQL script 
+ + + + + + 

Executing SQL script + + + + + + 

Duplicate/empty/truncate tables + + + + + + 

Create table/view shortcut on desktop + + + + - - 

Ability to create Favorites list + - + - + - 

Ability to set auto-save for Query, 

Function, etc 
+ + + + + + 

Print database/schema/table 

structure 
+ - + - + - 

Support of docking/tab windows + + + + - - 

Support of virtual grouping: provide 

logical organization over connections 

and objects 

+ - + - + - 

Ability to run profile from command 

line 
+ + + + + + 

Log files: keep track on the actions 

have been performed in Navicat 
+ + + + + + 

Ability to copy Connection 

Information into Clipboard 
+ + + + + + 

 

To download Lite version - Navicat Lite version
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Navicat for MySQL 

 

Platforms 

Windows 

Enterprise 

Edition 

Windows 

Standard 

Edition 

Windows 

Lite 

Edition 

Mac OS X 

Standard 

Edition 

Mac 

OS X 

Lite 

Edition 

Linux 

Standard 

Edition 

Linux 

Lite 

Edition 

MySQL Objects Management 

Supports MySQL Servers 

3.21 or above 
+ + + + + + + 

Create / Drop Databases + + + + + + + 

Support all MySQL objects: 

tables, views, stored 

procedures/functions and 

events 

+ + + + + + + 

Support all subobjects: 

fields, indices, foreign keys 

and triggers 

+ + + + + + + 

Support of partitioning + + + + + + + 

Support of character set and 

unicode 
+ + + + + + + 

Connection Management and Navigation 

Multiple local/remote MySQL 

server connections 
+ + + + + + + 

Connection to MySQL Server 

through SSH 
+ + + + + + + 

Connection to MySQL Server 

through HTTP  
+ + + + + + + 

Support SSL secure 

connection 
+ + + + + + + 

Keep connection alive + + + + + + + 

Export/Import connections 

settings 
+ + + + + + + 

Customize selected datbases 

to work with 
+ + + + + + + 



 

Welcome to Navicat 

 
Data Viewer and Editor 

Grid view  + + + + + + + 

Form view + + - + - + - 

Text, Hex and BLOB 

viewer/editor 
+ + + + + + + 

Copying and pasting selected 

records 
+ + + + + + + 

Customize display formats + + + + + + + 

Incremental search, sorting 

and formatting table grid 
+ + + + + + + 

Support of raw mode edit: 

apply MySQL built-in function 
+ + + + + + + 

Support of foreign key data 

selection: locate the 

available values from the 

reference table 

+ + - + - + - 

Filtering Records + + - + - + - 

Ability to set number of 

records showing on each 

page 

+ + + + + + + 

SQL Processing 

Visual query/view builder to 

facilitate the process of 

building complicated queries 

+ + - + - + - 

Ability to create parameter 

queries 
+ + + + + + + 

Code completion for SQL 

editors 
+ + - + - + - 

SQL Code Beautifier + + + + + + + 

Multiple SQL editors with 

syntax highlighted feature 
+ + + + + + + 

Support code folding, 

highlighted matches words 

and brackets 

+ + + + + + + 

Copy SQL with quote + + + + + + + 

Word Wrap + + + + + + + 
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Zoom In/Out for SQL editors + + + + + + + 

Enhanced find and replace 

options in SQL editors 
+ + + + + + + 

Ability to preview SQL before 

execution 
+ + + + + + + 

Support to return 

multi-resultsets 
+ + + - - + + 

SQL console + + + + + - - 

Diversified Import and Export Competence 

Importing data from ODBC: 

MSSQL, Oracle etc 
+ + - + - - - 

Importing data from MS 

Excel  
+ + - + - - - 

Importing data from MS 

Access  
+ + - - - - - 

Importing data from plain 

text file formats : TXT, CSV, 

XML etc 

+ + + + + + + 

Importing data from other 

file formats : DBF etc 
+ + - + - + - 

Exporting data to MS Excel + + - + - + - 

Exporting data to MS Access + + - - - - - 

Exporting data to HTML + + - - - + - 

Exporting data to plain text 

file formats: TXT, CSV, XML 

etc 

+ + + + + + + 

Exporting data to most 

popular formats: DBF etc 
+ + - + - + - 

Other Data Manipulation Tools  

Data transfer + + - + - + - 

Transferring data to SQL 

script as INSERT statement 
+ + - + - + - 

Transferring data to a SQL 

file with designated SQL 

format and encoding 

+ + - + - + - 

Data synchronization + + - + - + - 
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Structure synchronization + + - + - + - 

Backup/Restore 

Backing up/restoring 

database 
+ + - + - + - 

Backing up database with 

chosen database objects 
+ + - + - + - 

Restoring database with 

chosen database objects 
+ + - + - + - 

Converting backup file into 

SQL script 
+ + - + - + - 

Compressing/Decompressing 

Backup files 
+ + - - - + - 

Schedule for Batch Job 

Ability to set schedule on 

backup, query execution, 

import/export, data transfer 

and data synchronization 

+ + - + - + - 

Schedule report printing + - - - - - - 

Schedule to print report to 

files: PDF, Excel, HTML etc 
+ - - - - - - 

Sending notification e-mail 

for schedule task 
+ + - + - + - 

Ability to attach Export 

Wizard/Report result files in 

Batch Job notification email 

+ + - + - + - 

Notification email supports 

SSL/TLS 
+ + - - - + - 

Server Security and Maintenance Services 

Visual user manager to 

administer users and 

privileges  

+ + + + + + + 

Ability to duplicate user + + - + - + - 

Maintance database objects + + + + + + + 

Server Monitor to view and 

change system variables, to 

view server status 

information 

+ + - + - + - 
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Report Management Tools 

Report Builder + - - - - - - 

Report Viewer + - - - - - - 

Other Useful Features 

Objects search filter + + + + + + + 

Backing up database/table to 

SQL script 
+ + + + + + + 

Executing SQL script + + + + + + + 

Duplicate/empty/truncate 

tables 
+ + + + + + + 

Create table/view shortcut 

on desktop  
+ + + + + - - 

Ability to create Favorites list + + - + - + - 

Ability to set auto-save for 

Query, Function, etc 
+ + + + + + + 

Print database/table 

Structure 
+ + - + - + - 

Support of docking/tab 

windows 
+ + + + + - - 

Support of virtual grouping: 

provide logical organization 

over connections and objects 

+ + - + - + - 

Ability to run profile from 

command line 
+ + + + + + + 

Log files: keep track on the 

actions have been performed 

in Navicat 

+ + + + + + + 

Ability to copy Connection 

Information into Clipboard 
+ + + + + + + 

 
 
 

To download Lite version - Navicat Lite version
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Navicat for Oracle 

Platforms 

Windows 

Enterprise 

Edition 

Windows 

Standard 

Edition 

Windows 

Lite 

Edition 

Mac OS X 

Standard 

Edition 

Mac 

OS X 

Lite 

Edition 

Linux 

Standard 

Edition 

Linux 

Lite 

Edition 

Oracle Objects Management 

Supports Oracle Servers 8.1 

or above  
+ + + + + + + 

Create/drop schemas + + + + + + + 

Support all Oracle objects: 

tables (Normal, External and 

Index Organized), views, 

stored procedures/functions 

+ + + + + + + 

Support all subobjects: 

fields, indices, foreign keys, 

uniques, checks and triggers 

+ + + + + + + 

Managing directories, 

tablespaces, public database 

links and public synonyms 

+ + + + + + + 

Managing database links, 

indices, java, materialized 

views, materialized view 

logs, packages, sequences, 

synonyms, triggers, types, 

XML Schema and Recycle 

Bin. 

+ + + + + + + 

Support of physical 

attributes 
+ + + + + + + 

Support of character set and 

unicode 
+ + + + + + + 

Connection Management and Navigation 

Multiple local/remote Oracle 

server connections 
+ + + + + + + 

Support of Basic Connection + + + + + + + 

Support of TNS Connection + + + + + - - 

Connection to Oracle Server 

through SSH 
+ + + + + + + 
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Export/Import connections 

settings 
+ + + + + + + 

Feature Rich Oracle PL/SQL Code Debugger 

Support on showing 

interactive and real-time 

debugging information 

+ + - + - + - 

Ability to set simple and 

complex breakpoints 
+ + - + - + - 

Stepping through a function, 

i.e. Step Into, Step Over and 

Step Out 

+ + - + - + - 

Inspecting variables and 

expressions 
+ + - + - + - 

Stack traces + + - + - + - 

Data Viewer and Editor 

Grid view + + + + + + + 

Form view + + - + - + - 

TEXT, Hex and BLOB/BFile 

viewer/editor 
+ + + + + + + 

Copying and pasting selected 

records 
+ + + + + + + 

Customize display formats + + + + + + + 

Incremental search, sorting 

and formatting table grid 
+ + + + + + + 

Ability to show/hide table 

ROWID 
+ + + + + + + 

Support of foreign key data 

selection: locate the 

available values from the 

reference table 

+ + - + - + - 

Filtering Records + + - + - + - 

Ability to set number of 

records showing on each 

page 

+ + + + + + + 
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SQL Processing 

Visual query/view builder to 

facilitate the process of 

building complicated queries 

+ + - + - + - 

Ability to create parameter 

queries 
+ + + + + + + 

Code completion for SQL 

editors 
+ + - + - + - 

Code outline for Oracle 

functions/procedures/packa

ges/types 

+ + - + - + - 

SQL Code Beautifier + + + + + + + 

Multiple SQL editors with 

syntax highlighted feature 
+ + + + + + + 

Support code folding, 

highlighted matches words 

and brackets 

+ + + + + + + 

Copy SQL with quote + + + + + + + 

Word Wrap + + + + + + + 

Zoom In/Out for SQL editors + + + + + + + 

Enhanced find and replace 

options in SQL editors 
+ + + + + + + 

Ability to preview SQL before 

execution 
+ + + + + + + 

Support to return 

multi-resultsets 
+ + + - - + + 

SQL*Plus + + + + + - - 

Diversified Import and Export Competence 

Importing data from ODBC: 

MSSQL etc 
+ + - + - - - 

Importing data from MS 

Excel 
+ + - + - - - 

Importing data from MS 

Access 
+ + - - - - - 

Importing data from plain 

text file formats : TXT, CSV, 
+ + + + + + + 
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XML etc 

Importing data from other 

file formats : DBF etc 
+ + - + - + - 

Exporting data to MS Excel  + + - + - + - 

Exporting data to MS Access + + - - - - - 

Exporting data to HTML + + - - - + - 

Exporting data to plain text 

file formats : TXT, CSV, XML 

etc 

+ + + + + + + 

Exporting data to most 

popular formats: DBF etc 
+ + - + - + - 

Other Data Manipulation Tools 

Data transfer + + - + - + - 

Transferring data to SQL 

script as INSERT statement 
+ + - + - + - 

Transferring data to a SQL 

file with designated SQL 

format and encoding 

+ + - + - + - 

Data synchronization + + - + - + - 

Structure synchronization + + - + - + - 

Schedule for Batch Job  

Ability to set schedule on 

query execution, 

import/export, data transfer 

and data synchronization 

+ + - + - + - 

Schedule report printing + - - - - - - 

Schedule to print report to 

files: PDF, Excel, HTML etc 
+ - - - - - - 

Sending notification e-mail 

for schedule task 
+ + - + - + - 

Ability to attach Export 

Wizard/Report result files in 

Batch Job notification email 

+ + - + - + - 

Notification email supports 

SSL/TLS 
+ + - - - + - 
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Server Security and Maintenance Services 

Visual user manager to 

administer users, roles and 

privileges 

+ + + + + + + 

Maintaining tables like Table 

Lock, Row Movement, Shrink 

Space, Table Move, Validate 

Table Structure and Collect 

Table Statistics 

+ + + + + + + 

Server Monitor to view and 

change system variables, to 

view server status 

information 

+ + - + - + - 

Report Management Tools 

Report Builder + - - - - - - 

Report Viewer + - - - - - - 

Other Useful Features 

Objects search filter + + + + + + + 

Backing up schema/table to 

SQL script 
+ + + + + + + 

Executing SQL script + + + + + + + 

Duplicate/empty/truncate 

tables 
+ + + + + + + 

Create table/view shortcut 

on desktop  
+ + + + + - - 

Ability to create Favorites list + + - + - + - 

Ability to set auto-save for 

Query, Function, etc 
+ + + + + + + 

Print Schema Structure + + - + - + - 

Support of docking/tab 

windows 
+ + + + + - - 

Support of virtual grouping: 

provide logical organization 

over connections and objects 

+ + - + - + - 

Ability to run profile from 

command line 
+ + + + + + + 
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Log files: keep track on the 

actions have been performed 

in Navicat 

+ + + + + + + 

Ability to copy Connection 

Information into Clipboard 
+ + + + + + + 

 

To download Lite version - Navicat Lite version
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Navicat for PostgreSQL 

Platforms 

Windows 

Enterprise 

Edition 

Windows 

Standard 

Edition 

Windows 

Lite 

Edition 

Mac OS X 

Standard 

Edition 

Mac 

OS X 

Lite 

Edition 

Linux 

Standard 

Edition 

Linux 

Lite 

Edition 

PostgreSQL Objects Management 

Supports PostgreSQL 

Servers 7.3 or above 
+ + + + + + + 

Create /drop databases and 

schemas 
+ + + + + + + 

Support all PostgreSQL 

objects: tables, views and 

functions 

+ + + + + + + 

Support all subobjects: 

fields, indices, foreign keys, 

uniques, checks, rules and 

triggers 

+ + + + + + + 

Managing tablespace + + + + + + + 

Managing cast and 

languages 
+ + + + + + + 

Managing aggregates, 

conversions, domains, 

trigger functions, operators 

and classes, sequences and 

types 

+ + + + + + + 

Support of character set 

and unicode 
+ + + + + + + 

Connection Management and Navigation 

Multiple local/remote 

PostgreSQL server 

connections 

+ + + + + + + 

Connection to PostgreSQL 

Server through SSH 
+ + + + + + + 

Connection to PostgreSQL 

Server through HTTP 
+ + + + + + + 
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Support SSL secure 

connection for PostgreSQL 

8.4 above 

+ + + + + + + 

Export/Import connections 

settings 
+ + + + + + + 

Customize selected 

databases to work with 
+ + + + + + + 

Data Viewer and Editor 

Grid view + + + + + + + 

Form view + + - + - + - 

Text, Hex and BLOB 

viewer/editor 
+ + + + + + + 

Copying and pasting 

selected records 
+ + + + + + + 

Customize display formats + + + + + + + 

Incremental search, sorting 

and formatting table grid 
+ + + + + + + 

Support of raw mode edit: 

apply PostgreSQL built-in 

function 

+ + + + + + + 

Support of foreign key data 

selection: locate the 

available values from the 

reference table 

+ + - + - + - 

Filtering Records + + - + - + - 

Ability to set number of 

records showing on each 

page 

+ + + + + + + 

SQL Processing 

Visual query/view builder 

to facilitate the process of 

building complicated 

queries 

+ + - + - + - 

Ability to create parameter 

queries 
+ + + + + + + 
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Code completion for SQL 

editors 
+ + - + - + - 

SQL Code Beautifier + + + + + + + 

Multiple SQL editors with 

syntax highlighted feature 
+ + + + + + + 

Support code folding, 

highlighted matches words 

and brackets 

+ + + + + + + 

Copy SQL with quote + + + + + + + 

Word Wrap + + + + + + + 

Zoom In/Out for SQL 

editors 
+ + + + + + + 

Enhanced find and replace 

options in SQL editors 
+ + + + + + + 

Ability to preview SQL 

before execution 
+ + + + + + + 

Support to return 

multi-resultsets 
+ + + - - + + 

SQL console + + + + + - - 

Diversified Import and Export Competence 

Importing data from ODBC: 

MSSQL, Oracle etc 
+ + - + - - - 

Importing data from MS 

Excel 
+ + - + - - - 

Importing data from MS 

Access 
+ + - - - - - 

Importing data from plain 

text file formats : TXT, CSV, 

XML etc 

+ + + + + + + 

Importing data from other 

file formats : DBF etc 
+ + - + - + - 

Exporting data to MS Excel + + - + - + - 

Exporting data to MS 

Access  
+ + - - - - - 

Exporting data to HTML + + - - - + - 
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Exporting data to plain text 

file formats : TXT, CSV, 

XML etc 

+ + + + + + + 

Exporting data to most 

popular formats: DBF etc 
+ + - + - + - 

Other Data Manipulation Tools 

Data transfer + + - + - + - 

Transferring data to SQL 

script as INSERT statement 
+ + - + - + - 

Transferring data to a SQL 

file with designated SQL 

format and encoding 

+ + - + - + - 

Data synchronization + + - + - + - 

Structure synchronization + + - + - + - 

Backup/Restore 

Backing up/restoring 

database 
+ + - + - + - 

Backing up database with 

chosen database objects 
+ + - + - + - 

Restoring database with 

chosen database objects 
+ + - + - + - 

Converting backup file into 

SQL script 
+ + - + - + - 

Compressing/Decompressi

ng Backup files 
+ + - - - + - 

Schedule for Batch Job  

Ability to set schedule on 

backup, query execution, 

import/export, data 

transfer and data 

synchronization 

+ + - + - + - 

Schedule report printing + - - - - - - 

Schedule to print report to 

files: PDF, Excel, HTML etc 
+ - - - - - - 

Sending notification e-mail 

for schedule task 
+ + - + - + - 
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Ability to attach Export 

Wizard/Report result files in 

Batch Job notification email 

+ + - + - + - 

Notification email supports 

SSL/TLS 
+ + - - - + - 

Server Security and Maintenance Services 

Visual user manager to 

administer users, groups 

(roles) and privileges 

+ + + + + + + 

Analyzing, vacuuming and 

reindexing tables 
+ + + + + + + 

Server Monitor to view 

system variables and 

server status information 

+ + - + - + - 

Report Management Tools 

Report Builder + - - - - - - 

Report Viewer + - - - - - - 

Other Useful Features 

Objects search filter + + + + + + + 

Backing up schema/table to 

SQL script 
+ + + + + + + 

Executing SQL script + + + + + + + 

Duplicate/empty/truncate 

tables 
+ + + + + + + 

Create table/view shortcut 

on desktop  
+ + + + + - - 

Ability to create Favorites 

list 
+ + - + - + - 

Ability to set auto-save for 

Query, Function, etc 
+ + + + + + + 

Print database/table 

Structure 
+ + - + - + - 

Support of docking/tab 

windows 
+ + + + + - - 
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Support of virtual 

grouping: provide logical 

organization over 

connections and objects 

+ + - + - + - 

Ability to run profile from 

command line 
+ + + + + + + 

Log files: keep track on the 

actions have been 

performed in Navicat 

+ + + + + + + 

Ability to copy Connection 

Information into Clipboard 
+ + + + + + + 

 

To download Lite version - Navicat Lite version

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.navicat.com/en/download/download.html
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Navicat for SQLite 

 

Platforms 

Windows 

Enterprise 

Edition 

Windows 

Standard 

Edition 

Windows 

Lite 

Edition 

Mac OS X 

Standard 

Edition 

Mac 

OS X 

Lite 

Edition 

Linux 

Standard 

Edition 

Linux 

Lite 

Edition 

SQLite Objects Management 

Supports SQLite 2 and 3 + + + + + + + 

Attach/detach databases + + + + + + + 

Support all SQLite objects: 

tables and views 
+ + + + + + + 

Support all subobjects: 

triggers and indices 
+ + + + + + + 

Support to view master table + + + + + + + 

Support of character set and 

unicode 
+ + + + + + + 

Connection Management and Navigation 

Multiple local/remote SQLite 

database connections 
+ + + + + + + 

Support to connect a new or 

an existing database 
+ + + + + + + 

Support encrypted SQLite file 

(wxSQLite3) 
+ + + + + + + 

Connection to SQLite 

database through HTTP  
+ + + + + + + 

Export/Import connections 

settings 
+ + + + + + + 

Data Viewer and Editor 

Grid view  + + + + + + + 

Form view + + - + - + - 

Text, Hex and BLOB 

viewer/editor 
+ + + + + + + 

Copying and pasting selected 

records 
+ + + + + + + 

Customize display formats + + + + + + + 
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Incremental search, sorting 

and formatting table grid 
+ + + + + + + 

Support of raw mode edit: 

apply SQLite built-in function 
+ + + + + + + 

Ability to show/hide ROWID + + + + + + + 

Support of foreign key data 

selection: locate the 

available values from the 

reference table 

+ + - + - + - 

Filtering Records + + - + - + - 

Ability to set number of 

records showing on each 

page 

+ + + + + + + 

SQL Processing 

Visual query/view builder to 

facilitate the process of 

building complicated queries 

+ + - + - + - 

Ability to create parameter 

queries 
+ + + + + + + 

Code completion for SQL 

editors 
+ + - + - + - 

SQL Code Beautifier + + + + + + + 

Multiple SQL editors with 

syntax highlighted feature 
+ + + + + + + 

Support code folding, 

highlighted matches words 

and brackets 

+ + + + + + + 

Copy SQL with quote + + + + + + + 

Word Wrap + + + + + + + 

Zoom In/Out for SQL editors + + + + + + + 

Enhanced find and replace 

options in SQL editors 
+ + + + + + + 

Ability to preview SQL before 

execution 
+ + + + + + + 
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Support to return 

multi-resultsets 
+ + + - - + + 

SQL Concole + + - + - - - 

Diversified Import and Export Competence 

Importing data from ODBC: 

MSSQL, Oracle etc 
+ + - + - - - 

Importing data from MS 

Excel  
+ + - + - - - 

Importing data from MS 

Access  
+ + - - - - - 

Importing data from plain 

text file formats : TXT, CSV, 

XML etc 

+ + + + + + + 

Importing data from other 

file formats : DBF etc 
+ + - + - + - 

Exporting data to MS Excel + + - + - + - 

Exporting data to MS Access + + - - - - - 

Exporting data to HTML + + - - - + - 

Exporting data to plain text 

file formats : TXT, CSV, XML 

etc 

+ + + + + + + 

Exporting data to most 

popular formats: DBF etc 
+ + - + - + - 

Other Data Manipulation Tools  

Data transfer + + - + - + - 

Transferring data to SQL 

script as INSERT statement 
+ + - + - + - 

Transferring data to a SQL 

file with designated SQL 

format and encoding 

+ + - + - + - 

Data synchronization + + - + - + - 

Structure synchronization + + - + - + - 

Backup/Restore 

Backing up/restoring 

database 
+ + - + - + - 
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Backing up/restoring 

database with chosen 

database objects 

+ + - + - + - 

Converting backup file into 

SQL script 
+ + - + - + - 

Compressing/Decompressing 

Backup files 
+ + - - - + - 

Schedule for Batch Job 

Ability to set schedule on 

backup, query execution, 

import/export, data transfer 

and data synchronization 

+ + - + - + - 

Schedule report printing + - - - - - - 

Schedule to print report to 

files: PDF, Excel, HTML etc 
+ - - - - - - 

Sending notification e-mail 

for schedule task 
+ + - + - + - 

Ability to attach Export 

Wizard/Report result files in 

Batch Job notification email 

+ + - + - + - 

Notification email supports 

SSL/TLS 
+ + - - - + - 

Server Security and Maintenance Services 

Analyzing, re-indexing tables + + + + + + + 

Report Management Tools 

Report Builder + - - - - - - 

Report Viewer + - - - - - - 

Other Useful Features 

Objects search filter + + + + + + + 

Backing up database/table to 

SQL script 
+ + + + + + + 

Executing SQL script + + + + + + + 

Duplicate/empty/truncate 

tables 
+ + + + + + + 

Create table/view shortcut 

on desktop  
+ + + + + - - 
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Ability to create Favorites list + + - + - + - 

Ability to set auto-save for 

Query, etc 
+ + + + + + + 

Print database/table 

Structure 
+ + - + - + - 

Support of docking/tab 

windows 
+ + + + + - - 

Support of virtual grouping: 

provide logical organization 

over connections and objects 

+ + - + - + - 

Ability to run profile from 

command line 
+ + + + + + + 

Log files: keep track on the 

actions have been performed 

in Navicat 

+ + + + + + + 

Ability to copy Connection 

Information into Clipboard 
+ + + + + + + 

 

To download Lite version - Navicat Lite version

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.navicat.com/en/download/download.html
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Registration 

To make it economic and efficient for you to purchase our products, over 95% of customers 

order Navicat via our Online Shop using major Credit Cards - MasterCard, Visa, Euro card, 

JCB and American Express. All Online orders are processed by Share-it! and worldpay. The 

VeriSign Certificate for SSL transactions provided will ensure you a secured Online 

transactions.  

If you have ordered Navicat software and would like to review your order information, or if 

you have questions about ordering, payments, or shipping procedures, please contact our 

Navicat Sales Department. 

After purchase you will obtain a Registration Key to activate your licensed Navicat by 

e-mail within 24 hours after we received your order. Please make sure to enter a valid e-mail 

address in your order. If you have not received the keys within 24 hours, it is probably that 

the e-mail we sent was blocked by your email spam filter. To resend your download 

information and keys, please submit your registered email address to 

http://support.navicat.com/upgrade.php. If you get no reply from the resend form, please 

contact our Navicat Sales Department. 

Besides, if you feel uncomfortable with providing your personal information over the Internet, 

we accept Purchase Order and Bank/Wire Transfer. Please visit our Offline Order. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.navicat.com/en/buynow/store.html
http://support.navicat.com/?_a=tickets&_m=submit
http://support.navicat.com/upgrade.php
http://support.navicat.com/?_a=tickets&_m=submit
http://www.navicat.com/en/buynow/order_other_method.html
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Installation 

We strongly suggest that you shut down any opened applications. This will help ensure a 

smooth installation.  

Note: Installing Navicat does not include the server installation. You should download and 

install the server manually. 

Note: For user who has been trying our unregistered version, just simply key in the 

Registration Key (16 digit) on the pop up Registration screen. 

Installation for Online Version 

1. Open or Save the gzip file.  

2. Extract the file into anywhere you wish.  

3. Open the unziped folder.  

4. Double-click start_navicat to start your Navicat. Please note that it would take a 

while for starting-up.  

5. A Registration screen will then be popup, key in the Registration Key (16 digit).  

Installation for CD Version 

1. Load the Navicat CD Installation disk into the CD-ROM drive.  

2. Extract the gzip file into anywhere you wish.  

3. Open the unziped folder.  

4. Double-click start_navicat to start your Navicat. Please note that it would take a 

while for starting-up.  

5. A Registration screen will then be popup, key in the Registration Key (16 digit).  

Migrate Navicat to new computer 

All your connection settings are stored in a user.reg file. To view the registry record, in Linux 

(login as root for example), open /root/.navicat/user.reg where .navicat is a hidden 

folder. 

1. In Navicat, choose File -> Export Connections. The exported file (.ncx) contains all 

your connection settings.  

2. Backup the exported file (.ncx).  

3. Uninstall Navicat from the existing computer.  

4. Re-install Navicat in the new computer.  

5. Open Navicat and choose File -> Import Connections in the new computer.  
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When a new connection being established, Navicat will create a subfolder under the Settings 

Save Path. Most files are stored within this subfolder. To look for the path, right click the 

connection and choose Connection Properties -> Advanced -> Settings Save Path.  

Moreover, all your saved profiles are stored under profiles. To look for the path, choose Tools 

-> Options -> Miscellaneous -> Profiles Save Path. 
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Upgrade 

How to upgrade your Navicat? 

If you want to upgrade installed copy of Navicat to the latest release, please submit your 

registered email address on the upgrade page at: 

 

http://support.navicat.com/upgrade.php

 

 

 
 
 
 
 
 
 
 
 
 
 
 

http://support.navicat.com/upgrade.php
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End-User License Agreement 

IMPORTANT: THIS SOFTWARE END USER LICENSE AGREEMENT ("EULA") IS A LEGAL 

AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR, IF PURCHASED OR OTHERWISE 

ACQUIRED BY OR FOR AN ENTITY, AN ENTITY) AND PREMIUMSOFT CYBERTECH LTD..READ 

IT CAREFULLY BEFORE COMPLETING THE INSTALLATION PROCESS AND USING THE 

SOFTWARE. IT PROVIDES A LICENSE TO USE THE SOFTWARE AND CONTAINS WARRANTY 

INFORMATION AND LIABILITY DISCLAIMERS. BY INSTALLING AND USING THE SOFTWARE, 

YOU ARE CONFIRMING YOUR ACCEPTANCE OF THE SOFTWARE AND AGREEING TO BECOME 

BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO BE BOUND BY 

THESE TERMS, THEN DO NOT INSTALL THE SOFTWARE AND RETURN THE SOFTWARE TO 

YOUR PLACE OF PURCHASE. THIS EULA SHALL APPLY ONLY TO THE SOFTWARE SUPPLIED 

BY PREMIUMSOFT CYBERTECH LTD. HEREWITH REGARDLESS OF WHETHER OTHER 

SOFTWARE IS REFERRED TO OR DESCRIBED HEREIN.  

1. Definitions 

a. "Non-commercial Version" means a version of the Software, so identified, for use by i) 

the individual who is a natural person and not a corporation, company, partnership or 

association or other entity or organization (ii) the individual who is a student, faculty 

or staff member at an educational institution, and (iii) staff of a non-profit 

organization or charity organization only. For purposes of this definition, "educational 

institution" means a public or private school, college, university and other post 

secondary educational establishment. A non-profit organization is an organization 

whose primary objective is to support an issue or matter of private interest or public 

concern for non-commercial purposes.  

b. "Not For Resale (NFR) Version" means a version, so identified, of the Software to be 

used to review and evaluate the Software, only.  

c. "PremiumSoft" means PREMIUMSOFT CYBERTECH LTD. and its licensors, if any.  

d. "Software" means only the PremiumSoft software program(s) and third party 

software programs, in each case, supplied by PremiumSoft herewith, and 

corresponding documentation, associated media, printed materials, and online or 

electronic documentation.  

e. "Unregistered version", "Trial version" or "Demo version" means an unregistered copy 

of the SOFTWARE ("UNREGISTERED SOFTWARE") which may be used by the USER for 

evaluation purposes for a period of thirty (30) days following the initial installation of 

the UNREGISTERED SOFTWARE. At the end of the trial period ("TRIAL PERIOD"), the 

USER must either register the SOFTWARE or remove it from his system. The 
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UNREGISTERED SOFTWARE may be freely copied and distributed to other users for 

their evaluation.  

f. "Non-commercial Lite Version" means a version of the Software, so identified, to be 

used for non-commercial purpose. The Software or the applications or products 

created from the Software that are intended to be used in a business, commercial, or 

government environment, to be rented, leased, or sold for profit, or to otherwise 

provide a benefit, is prohibited. The non-commercial Lite Version has no any trial 

period restriction and is not fully functional as Trial or Demo version.  

2. License Grants 

The licenses granted in this Section 2 are subject to the terms and conditions set forth in this 

EULA:  

a. Subject to Section 2(b), you may install and use the Software on a single computer; 

OR install and store the Software on a storage device, such as a network server, used 

only to install the Software on your other computers over an internal network, 

provided you have a license for each separate computer on which the Software is 

installed and run. Except as otherwise provided in Section 2(b), a license for the 

Software may not be shared, installed or used concurrently on different computers.  

b. In addition to the single copy of the Software permitted in Section 2(a), the primary 

user of the computer on which the Software is installed may make a second copy of 

the Software and install it on either a portable computer or a computer located at his 

or her home for his or her exclusive use, provided that:  

A. the second copy of the Software on the portable or home computer (i) is not 

used at the same time as the copy of the Software on the primary computer and 

(ii) is used by the primary user solely as allowed for such version or edition 

(such as for educational use only),  

B. the second copy of the Software is not installed or used after the time such user 

is no longer the primary user of the primary computer on which the Software is 

installed.  

c. In the event the Software is distributed along with other PremiumSoft software 

products as part of a suite of products (collectively, the "Studio"), the license of the 

Studio is licensed as a single product and none of the products in the Studio, including 

the Software, may be separated for installation or use on more than one computer.  

d. You may make one copy of the Software in machine-readable form solely for backup 

purposes. You must reproduce on any such copy all copyright notices and any other 

proprietary legends on the original copy of the Software. You may not sell or transfer 

any copy of the Software made for backup purposes.  
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e. You agree that PremiumSoft may audit your use of the Software for compliance with 

these terms at any time, upon reasonable notice. In the event that such audit reveals 

any use of the Software by you other than in full compliance with the terms of this 

Agreement, you shall reimburse PremiumSoft for all reasonable expenses related to 

such audit in addition to any other liabilities you may incur as a result of such 

non-compliance.  

f. Your license rights under this EULA are non-exclusive.  

3. License Restrictions 

a. Other than as set forth in Section 2, you may not make or distribute copies of the 

Software, or electronically transfer the Software from one computer to another or 

over a network.  

b. You may not alter, merge, modify, adapt or translate the Software, or decompile, 

reverse engineer, disassemble, or otherwise reduce the Software to a 

human-perceivable form.  

c. Unless otherwise provided herein, you may not rent, lease, or sublicense the 

Software.  

d. Other than with respect to a Trial / Demo Version, Non-commercial Lite Version or a 

Not For Resale Version of the Software, you may permanently transfer all of your 

rights under this EULA only as part of a sale or transfer, provided you retain no copies, 

you transfer all of the Software (including all component parts, the media and printed 

materials, any upgrades, this EULA, the serial numbers, and, if applicable, all other 

software products provided together with the Software), and the recipient agrees to 

the terms of this EULA. If the Software is an upgrade, any transfer must include all 

prior versions of the Software from which you are upgrading. If the copy of the 

Software is licensed as part of the whole Studio (as defined above), the Software shall 

be transferred only with and as part of the sale or transfer of the whole Studio, and not 

separately. You may retain no copies of the Software. You may not sell or transfer any 

Trial / Demo Version, Non-commercial Lite Version or Not For Resale Version of the 

Software.  

e. Unless otherwise provided herein, you may not modify the Software or create 

derivative works based upon the Software.  

f. Non-commercial Versions of the Software may not be used for, or distributed to any 

party for, any commercial purpose.  

g. Unless otherwise provided herein, you shall not  

A. in the aggregate, install or use more than one copy of the Trial / Demo Version 

and Non-commercial Lite Version of the Software,  
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B. download the Trial / Demo Version and Non-commercial Lite Version of the 

Software under more than one username,  

C. alter the contents of a hard drive or computer system to enable the use of the 

Trial / Demo Version of the Software for an aggregate period in excess of the 

trial period for one license to such Trial / Demo Version,  

D. disclose the results of software performance benchmarks obtained using the 

Trial / Demo Version or Non-commercial Lite Version to any third party without 

PremiumSoft prior written consent, or  

E. use the Trial / Demo Version of the Software for a purpose other than the sole 

purpose of determining whether to purchase a license to a commercial or 

education version of the software; provided, however, notwithstanding the 

foregoing, you are strictly prohibited from installing or using the Trial / Demo 

Version or Non-commercial Lite Version of the Software for any commercial 

training purpose.  

h. You may only use the Not for Resale Version of the Software to review and evaluate 

the Software.  

i. You may receive the Software in more than one medium but you shall only install or 

use one medium. Regardless of the number of media you receive, you may use only 

the medium that is appropriate for the server or computer on which the Software is to 

be installed.  

j. You may receive the Software in more than one platform but you shall only install or 

use one platform.  

k. You shall not use the Software to develop any application having the same primary 

function as the Software.  

l. In the event that you fail to comply with this EULA, PremiumSoft may terminate the 

license and you must destroy all copies of the Software (with all other rights of both 

parties and all other provisions of this EULA surviving any such termination).  

m. This program may include Oracle Instant Client (OCI). You agree that you shall  

1. not use of the Oracle Instant Client to the business operations;  

2. not assign, give, or transfer the Oracle Instant Client or an interest in them to 

another individual or entity;  

a. make the Programs available in any manner to any third party for use in 

the third party's business operations; and  

b. title to the Programs from passing to the end user or any other party;  

3. not reverse engineer, disassemble or decompilation the Oracle Instant Client 

and duplicate the Programs except for a sufficient number of copies of each 

Program for your licensed use and one copy of each Program media;  
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4. discontinue use and destroy or return to all copies of the Oracle Instant Client 

and documentation after termination of the Agreement;  

5. not pubish any results of benchmark tests run on the Programs;  

6. comply fully with all relevant export laws and regulations of the United States 

and other applicable export and import laws to assure that neither the Oracle 

Instant Client, nor any direct product thereof, are exported, directly or 

indirectly, in violation of applicable laws;  

7. allow PremiumSoft to audit your use of the Oracle Instant Client;  

4. Upgrades 

If this copy of the Software is an upgrade from an earlier version of the Software, it is 

provided to you on a license exchange basis. You agree by your installation and use of such 

copy of the Software to voluntarily terminate your earlier EULA and that you will not continue 

to use the earlier version of the Software or transfer it to another person or entity unless 

such transfer is pursuant to Section 3.  

5. Ownership 

The foregoing license gives you limited license to use the Software. PremiumSoft and its 

suppliers retain all rights, title and interest, including all copyright and intellectual property 

rights, in and to, the Software (as an independent work and as an underlying work serving as 

a basis for any application you may develop), and all copies thereof. All rights not specifically 

granted in this EULA, including Federal and International Copyrights, are reserved by 

PremiumSoft and its suppliers.  

6. LIMITED WARRANTY AND DISCLAIMER 

a. Except with respect to Trial / Demo Version, Non-commercial Lite Version and Not For 

Resale Version of the Software, PremiumSoft warrants that, for a period of thirty (30) 

days from the date of delivery (as evidenced by a copy of your receipt): the physical 

media on which the Software is furnished will be free from defects in materials and 

workmanship under normal use. The Software is provided "as is". PremiumSoft makes 

no warranties, express or implied, arising from course of dealing or usage of trade, or 

statutory, as to any matter whatsoever.  

b. PremiumSoft provides no remedies or warranties, whether express or implied, for 

Trial / Demo version, Non-commercial Lite version and the Not for Resale version of 

the Software. Trial / Demo version, Non-commercial Lite version and the Not for 

Resale version of the Software are provided "as is".  
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c. Except as set Forth in the foregoing limited warranty with respect to software other 

than Trial/ Demo version, Non-commercial Lite version and Not for Resale version, 

PremiumSoft and its suppliers disclaim all other warranties and representations, 

whether express, implied, or otherwise, including the warranties of merchantability or 

fitness for a particular purpose. Also, there is no warranty of non-infringement and 

title or quiet enjoyment. PremiumSoft does not warrant that the Software is error-free 

or will operate without interruption. The Software is not designed, intended or licensed 

for use in hazardous environments requiring fail-safe controls, including without 

limitation, the design, construction, maintenance or operation of nuclear facilities, 

aircraft navigation or communication systems, air traffic control, and life support or 

weapons systems. PremiumSoft specifically disclaims any express or implied warranty 

of fitness for such purposes.  

d. If applicable law requires any warranties with respect to the Software, all such 

warranties are limited in duration to thirty (30) days from the date of delivery.  

e. No oral or written information or advice given by PremiumSoft, its dealers, distributors, 

agents or employees shall create a warranty or in any way increase the scope of ANY 

warranty PROVIDED HEREIN.  

7. LIMITATION OF LIABILITY 

(a) Neither PremiumSoft nor its suppliers shall be liable to you or any third party for any 

indirect, special, incidental, punitive or consequential damages (including, but not limited to, 

damages for the inability to use equipment or access data, loss of business, loss of profits, 

business interruption or the like), arising out of the use of, or inability to use, the Software 

and based on any theory of liability including breach of contract, breach of warranty, 

tort (including negligence), product liability or otherwise, even if PremiumSoft or its 

representatives have been advised of the possibility of such damages.  

8. Third Party Software 

The Software may contain third party software which requires notices and/or additional 

terms and conditions. By accepting this EULA, you are also accepting the additional terms 

and conditions of the third party software.  

9. General 

No PremiumSoft dealer, agent or employee is authorized to make any amendment to this 

EULA.  
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This EULA contains the complete agreement between the parties with respect to the subject 

matter hereof, and supersedes all prior or contemporaneous agreements or understandings, 

whether oral or written. You agree that any varying or additional terms contained in any 

purchase order or other written notification or document issued by you in relation to the 

Software licensed hereunder shall be of no effect. The failure or delay of PremiumSoft to 

exercise any of its rights under this EULA or upon any breach of this EULA shall not be 

deemed a waiver of those rights or of the breach. 

If any provision of this EULA shall be held by a court of competent jurisdiction to be contrary 

to law, that provision will be enforced to the maximum extent permissible, and the remaining 

provisions of this EULA will remain in full force and effect.  

10. Basis of Bargain 

The Limited Warranty and Disclaimer and Limited Liability set forth above are fundamental 

elements of the basis of the agreement between PremiumSoft and you. PremiumSoft would 

not be able to provide the Software on an economic basis without such limitations. Such 

Limited Warranty and Disclaimer and Limited Liability inure to the benefit of PremiumSoft's 

licensors.  

11. Term 

By downloading and/or installing this SOFTWARE, the Licensor agrees to the terms of this 

EULA. 

This license is effective until terminated. Licensor has the right to terminate your License 

immediately if you fail to comply with any term of this License.  

"as is". Licensor makes no warranties, express or implied, arising from course of dealing or 

usage of trade, or statutory, as to any matter whatsoever. In particular, any and all 

warranties or merchantability, fitness for a particular purpose or non-infringement of third 

party rights are expressly excluded. 

12. Governing Law 

This License will be governed by the laws in force in Hong Kong. You hereby consent to the 

non-exclusive jurisdiction and venue sitting in Hong Kong to resolve any disputes arising 

under this EULA. 
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Should you have any questions concerning the validity of this License, please contact: 

licensing@navicat.com. If you desire to contact the Licensor for any other reason, please 

contact support@navicat.com. 

PremiumSoft and other trademarks contained in the Software are trademarks or registered 

trademarks of PremiumSoft CyberTech Ltd. in the United States and/or other countries. 

Third party trademarks, trade names, product names and logos may be the trademarks or 

registered trademarks of their respective owners. You may not remove or alter any 

trademark, trade names, product names, logo, copyright or other proprietary notices, 

legends, symbols or labels in the Software. This EULA does not authorize you to use 

PremiumSoft or its licensors names or any of their respective trademarks. 
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